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Introduction 

 
 
Ce document est destiné en particulier aux étudiants de la troisième année licence (option: 
électronique), dont une partie du module 'mini-projet' consiste à étudier et à maitriser un 
logiciel de simulation des circuits et systèmes électroniques. 
 
Il s'agit d'une initiation au logiciel de simulation ISIS-PROTEUS, qui est largement utilisé ces 
dernières années comme outil pédagogique, en particulier pour sa simplicité due à son 
environnement graphique et interactif. 
 
Le document est rédigé d'une façon relativement simple, avec un niveau de difficulté 
progressif, afin qu'il soit même utile aux étudiants des autres options, et même des autres 
niveaux   
  
La finalité est de doter l'étudiant d'un outil, lui permettant en premier lieu une révision et une 
assimilation de quelques notions de base d'électricité et d'électronique. Cet outil facilitera 
aussi, par la suite la tache de l'étudiant durant la  réalisation de sont mini-projet.  
 
Les différents outils mis à la disposition de l'utilisateur dans ISIS-PROTEUS , permettent, 
outre la simulation, des analyses dans des domaines différents (temporel, fréquentiel), ainsi 
que des régimes différents (statique, dynamique). 
 
Les différents outils du logiciel sont décrits au fur et a mesure, via une série d'exemples et 
d'applications, couvrant différents domaines de l'électronique, allant des circuits analogiques 
simples (RLC, circuits à base de diodes et transistors, AOP,..)   
aux circuits numériques y compris les microcontrôleurs. 
 
Certain applications sont validées par des tests expérimentaux effectuées au niveau du 
laboratoire, afin de doter l'étudiant d'un esprit critique lui permettant d'analyser et de 
comparer les résultats obtenus, théoriquement, expérimentalement, et par simulation 
informatique. 
 
Le module ARES du logiciel PROTEUS, dédié à la conception des circuits imprimés est aussi 
présenté en bref vers la fin du document, en gardant la même approche basée sur une série 
d'exemple et d'applications.   
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Initiation à Isis PROTEUS 
 
Isis Proteus  est un logiciel de développement et de simulation  d'application via un 
environnement graphique simple et interactif. 
Ce TP est une initiation à ce logiciel, basé sur un ensemble d'exemples, dont les résultats  
doivent être comparés par la suite a ceux obtenus théoriquement et expérimentalement. 
 

  
I-  1. L’environnement de travail de PROTEUS 

 
Le lancement de PROTEUS donne un environnement classique de type Windows, constitué 
d’une fenêtre principale, et d'un ensemble de barres d'outils . 
Outre le menu classique permettant la gestion des fichiers, de l'affichage, et des options des 
projets,  
 la fenêtre principale comprend une Zone de travail destinée au développement des circuits à 
simuler et à tester. 
Une Bibliothèque d'objets affiche la liste des objets (circuits électriques, électroniques,...) 
utilisés dans l' application en cours. 
les différentes Touches magnétoscope constitues des raccourcis permettant le lancement de 
la simulation, ainsi que la mise en pause, l'exécution pas a pas, et l'arrêt  de la simulation.  
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1.2 La barre d'outils principale  
 
La boite verticale de boutons, comprend les 
principaux raccourcis nécessaires au 
développement  rapide d'applications. 
En plaçant le curseur de la souris sur un bouton, 
sans cliquer, une info-bulle affiche le nom du 
bouton, dont les plus importants sont: 
 
- Component mode (Mode Composant),  
Un clic sur ce bouton puis Component  from 
libraries), permet l'ajout de differents composants 
 
- Generator Mode (Mode Générateur) 
permettant l'accès aux différents types de 
générateurs 
 
-Instruments  
un raccourci permettant l'ajout des appareils de 
mesure tels que le voltmètre, l' ampèremètre, et 
l'oscilloscope.  
 
-Terminal 
permettant d'ajouter des points particuliers dans 
un schéma tels que les entrées/sorties ou Gnd 
 
Application 1  
 
- Lancer Proteus, puis éditer et 
simuler le circuit ci-contre. 
- Justifier les valeurs numériques 
obtenues. 
 
Remarque 1: 
les composants utilisées sont : 
- source de tension continue (Mode 
générateur) de 20v. 
- des résistances (modèle RES) de 10k 
- un voltmètre, et des ampèremètres (mode Instruments) 
- La référence GND (mode Terminal) 
 
Remarque 2: 
les composants (par exemple RES) peuvent 
être obtenus soit a partir de leur 
bibliothèque, soit via une recherche directe. 
 



Application 2 
 
Dans cette application on s'intéresse au redressement d'un signal alternatif par diode.
Outre le voltmètre et la charge r
   - Une diode (modele générique
   - Une source alternative Vsine
   - Un oscilloscope (mode Instruments)
   - Une fenêtre analogique (mode Graph)
   - Deux sondes de tension (mode P

- Simuler le schéma
- Modifier le schéma
- Comparer le taux d'ondulation théorique des deux 
-Ajouter en sortie, un 
470UF, et visualiser la sortie.
- Ajouter en sortie deux régulateurs 7805, 7812 et visualiser la sortie
 

Remarque 3: 
- Pour affecter une sonde à un graphe
du signal à visualiser. Puis glisser la sonde dans le graphe.
- Pour lancer la simulation, le graphe 
- Un double clic sur le graphe permet de fixer le temps de simulation 
200ms pour cet exemple). 

 
Remarque 4: 
Si l’oscilloscope ne s’affiche pas, Cliquer sur "
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Dans cette application on s'intéresse au redressement d'un signal alternatif par diode.
charge résistive, on utilisera: 
générique) de la bibliothèque "Diode" 

Vsine de la bibliothèque "Simulaor Primitives" 
nstruments) 

analogique (mode Graph) 
Deux sondes de tension (mode Probe) 

schéma proposé 
schéma pour avoir un redressement double alternance.

Comparer le taux d'ondulation théorique des deux signaux obtenus
Ajouter en sortie, un condensateur de filtrage (Modèle CAP) de 

470UF, et visualiser la sortie. 
Ajouter en sortie deux régulateurs 7805, 7812 et visualiser la sortie

ffecter une sonde à un graphe, il est nécessaire de sélectionner la sonde représentative 
glisser la sonde dans le graphe. 
le graphe doit être Pointé tout en appuyant sur la 

Un double clic sur le graphe permet de fixer le temps de simulation à afficher

ne s’affiche pas, Cliquer sur "debug / Oscilloscope" 

Dans cette application on s'intéresse au redressement d'un signal alternatif par diode. 

pour avoir un redressement double alternance. 
signaux obtenus 

condensateur de filtrage (Modèle CAP) de 

Ajouter en sortie deux régulateurs 7805, 7812 et visualiser la sortie 

électionner la sonde représentative 

sur la touche 'Espace' 
afficher (par exemple 



 
Application 3 
 
Le circuit suivant illustre un exemple de la commande d'un Relais (Relay), en 
utilisant un bouton poussoir (Button

 
 
- Définissez le principe d'une LDR
 
- Définissez le principe d'une L
 
- Définissez le principe de fonctionnement
commande. 
 
- Simuler et vérifier le fonctionnement du circuit.
 
-Dans le schéma proposé, justifier 
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e circuit suivant illustre un exemple de la commande d'un Relais (Relay), en 
un bouton poussoir (Button) et une LDR  

Définissez le principe d'une LDR 

Définissez le principe d'une LED 

Définissez le principe de fonctionnement d'un relais et de sa 

Simuler et vérifier le fonctionnement du circuit. 

Dans le schéma proposé, justifier l'utilité de la diode. 

e circuit suivant illustre un exemple de la commande d'un Relais (Relay), en 

d'un relais et de sa 

 



 
 

 
Dans cette partie on s’intéresse à
certains outils de PROTEUS permettant en particulier l'analyse fréquentielle et la 
fonctions de transfert des systèmes. 
 
 
2.1 Le circuit RC et CR 
 
Sous PROTEUS, il est possible de 
exploitant le graphe "Frequency response
 
Application 1: 
 
- Lancer PROTEUS, et éditer 
comprenant deux circuits un RC, et un CR.
- Chaque circuit comprend une pin d'entré 
(in1,in2) et une pin de sortie (out1,out2). Les deux 
pins sont issue du mode terminal
- Pour obtenir la réponse en fréquence de chaque 
circuit un graphe de type 'frequency response' est 
ajouté, en modifiant sa référence soit à 
le premier cas soit à 'in2' dans le deuxième cas.
 
 
remarque : 
Une sonde de tension doit être
fois vers la gauche du graphe, 
d'obtenir respectivement la variation de 
l'amplitude et de la phase du circuit en fonction 
de la fréquence. 
- Comparer les résultats de la simulation avec 
ceux obtenus théoriquement.  

2.2 Le circuit RL et LR 
 
Simuler les deux circuits RL et LR du schéma 
ci-contre, et comparer les réponses 
fréquentielles obtenues avec ceux déterminées 
théoriquement.   
 
2.3 Le circuit RLC  
 
Simuler et analyser théoriquement les réponse
fréquentielles du circuit RLC donnée dans le 
schéma suivant.  
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L'analyse des circuits RLC de base 

Dans cette partie on s’intéresse à l'analyse des circuits RLC de base, l'objectif est de métriser 
certains outils de PROTEUS permettant en particulier l'analyse fréquentielle et la 

de transfert des systèmes.  

 

il est possible de déterminer la fonction de transfert d'un système
Frequency response", et en précisant l'entrée et la sortie du 

 le schéma ci-contre 
comprenant deux circuits un RC, et un CR. 

Chaque circuit comprend une pin d'entré 
(out1,out2). Les deux 

issue du mode terminal. 
réponse en fréquence de chaque 

circuit un graphe de type 'frequency response' est 
ajouté, en modifiant sa référence soit à 'in1' dans 

dans le deuxième cas. 

être ajoutée, puis glissée une fois vers la droite, et une deuxieme 
fois vers la gauche du graphe, cela permettra 

obtenir respectivement la variation de 
l'amplitude et de la phase du circuit en fonction 

simulation avec 
 
 
 

 

Simuler les deux circuits RL et LR du schéma 
contre, et comparer les réponses 

fréquentielles obtenues avec ceux déterminées 

Simuler et analyser théoriquement les réponses 
s du circuit RLC donnée dans le 

 

l'objectif est de métriser 
certains outils de PROTEUS permettant en particulier l'analyse fréquentielle et la synthèse des 

système en 
cisant l'entrée et la sortie du système. 

s la droite, et une deuxieme 



 
Dans cette partie on s’intéresse 
utilisera pour cette raison le circuit
 
3.1. Montages de bases  
 
Pour chaque montage il est nécessaire de déterminer théoriquement la fonction réalisée et de 
simuler le fonctionnement. 
 
Montage 1 : 

Montage 2 : 

Montage  3 : 
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Les Amplificateurs Opérationnels 

Dans cette partie on s’intéresse à des montages à base d’amplificateurs opérationnels. On 
le circuit TL082 (voir le datasheet donné en annexe)

 

Pour chaque montage il est nécessaire de déterminer théoriquement la fonction réalisée et de 

 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 

 

base d’amplificateurs opérationnels. On 
donné en annexe).  

Pour chaque montage il est nécessaire de déterminer théoriquement la fonction réalisée et de 



 
 
Montage 4: 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 

3.2  Filtre actif 
 
- En considérant le montage suivant, déterminer théoriquement l'expression de sa r
fréquentielle. 
 
- Comparer le résultat avec celui obtenu 
PROTEUS 
 
-Réaliser expérimentalement le montage et 
du circuit, et comparer avec les r
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n considérant le montage suivant, déterminer théoriquement l'expression de sa r

Comparer le résultat avec celui obtenu en utilisant le module 'Frequency response' 

Réaliser expérimentalement le montage et prélever  point par point la réponse fréquentielle 
du circuit, et comparer avec les résultats de la simulation. 

 

 
 

n considérant le montage suivant, déterminer théoriquement l'expression de sa réponse 

le module 'Frequency response' de 

point par point la réponse fréquentielle 
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Le Circuit Multifonctions (NE555)  

 
 
Cette partie est consacrée à la simulation et à la réalisation de montages élémentaires à  base 
du circuit intégré NE555. Ce dernier a la particularité de permettre la réalisation de différentes 
fonctions électroniques liées à la gestion de temporisation. 
 
 4.1 Présentation du circuit 
Le NE555 est un circuit utilisé en particulier pour la gestion des temporisation en mode 
multivibrateur. ce circuit a été créé et commercialisé au début des années soixante-dix, mais 
en raison de sa simplicité, de son faible cout, et de sa stabilité, il est toujours utilisé dans les 
circuits 'timer' de base.   
le circuit est disponible généralement en boitier DIL (dual in line) de 8 pates, dont les 
appellations et les fonctions sont résumées dans le tableau suivant: 
 
 
N° Nom Description 
1 GND La masse 
2 TRIG Pin D'amorçage de la temporisation 

(détection d'une tension inferieur à 1/3 VCC 
3 OUT Signal de sortie 
4 RESET Réinitialisation /Interruption de la 

temporisation 
5 VCC L'alimentation 5v à 18v 
6 DISCH Pin permettant la décharge du condensateur 

de la temporisation 
7 THRES Pin déclenchant la fin de temporisation (la 

tension atteint en montant 2/3 VCC) 
8 CONT Pin donnant accès à  la référence interne (2/3 

VCC) 
 
4.2 Principe et diagramme fonctionnel 
 
Le NE555 est constitué de 23 transistors, 2 
diodes, et 16 résistances. 
 
Du point vue fonctionnel, le circuit peut  
être décrit par le schéma  ci-contre, 
comprenant : 
- Deux circuit comparateurs 
- Un diviseur de tension de 3 résistances 
identiques de 5k. 
Les tensions de référence sont respectivement 
1/3 et 2/3 VCC, et servent comme référence 
aux deux comparateurs 
- Une bascule SR (avec pin reset) contrôlée en 
entrée par les deux comparateurs 
-Un transistor permettant la décharge du 
condensateur de temporisation. 



 
 
le fonctionnement du circuit peut 
 
- Si RESET=0 : La bascule est remise à zéro, le transistor de décharge
reste à un niveau bas.  
 
- Si  TRIGGER< VCC/3 : la bascule est activée (SET) et la sortie est à un
transistor de décharge est désactivé.
 
- Si THRESHOLD > VCC.2/3
niveau bas, le transistor de décharge s'active.
 
- Dans le cas ou  THRESHOLD
conserve son état précédent, ainsi que 
 
 
4.3 Montage en monostable
 
Le Monostable est un circuit possédant un seul état stable, qu'il quitte uniquement 
impulsion sur son entrée (Trigger).
Apres une durée prédéfinie dans le second état, le circuit revient a son 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
- Simuler et vérifier le fonctionnement du circuit, en modifiant les valeurs de R1 et C1.
 
-Remplacer la partie déclanchement
les trois signaux indiqués dans le schém
 
-Justifier théoriquement et expérimentalement les temporisations obtenues
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du circuit peut être résumé comme suit: 

: La bascule est remise à zéro, le transistor de décharge s'active et la sortie 

: la bascule est activée (SET) et la sortie est à un
transistor de décharge est désactivé. 

/3 : la bascule est remise à zéro (RESET) et la sortie
niveau bas, le transistor de décharge s'active. 

HOLD < VCC.2/3  et  TRIGGER> VCC/3 ,  alors
ainsi que la sortie et le transistor de décharge. 

Montage en monostable 

un circuit possédant un seul état stable, qu'il quitte uniquement 
impulsion sur son entrée (Trigger). 
Apres une durée prédéfinie dans le second état, le circuit revient a son état 

er le fonctionnement du circuit, en modifiant les valeurs de R1 et C1.

déclanchement par un générateur d'impulsion, et visualiser dans un g
les trois signaux indiqués dans le schéma. 

Justifier théoriquement et expérimentalement les temporisations obtenues 

s'active et la sortie 

: la bascule est activée (SET) et la sortie est à un niveau haut, le 

: la bascule est remise à zéro (RESET) et la sortie est à un 

alors la bascule 
 

un circuit possédant un seul état stable, qu'il quitte uniquement après une 

initial. 

er le fonctionnement du circuit, en modifiant les valeurs de R1 et C1. 

t visualiser dans un graph 

 



 
 
 4.4 Montage en astable de base
 
Dans le cas du montage astable
fonctionne comme oscillateur.
la fréquence d'oscillation et le rapport 
cyclique sont fixés avec deux résistance
condensateur. 
Une oscillation complète est effectuée lorsqu
le condensateur se charge de 1
2/3 Vcc. 
 
Remarque  
 
Durant  la charge, les résistances R
sont en série avec le condensateur, mais la 
décharge s'effectue uniquement à travers R
Par conséquent le rapport cyclique peut être 
modifié.  
 
  
- Simuler et vérifier le fonctionnement du circuit, en modifiant les valeurs de R
-Visualiser dans un Graph les 
- Déterminer les limites du rapport cyclique qu'on peut avoir avec ce schéma.
- Déterminer théoriquement l'expression de la 
généré par ce montage 
- Vérifier  expérimentalement le
 
4.5 Montage en astable (MLI)
 
Afin de permettre une variation 
c'est a dire une modulation de largeur d'impulsion 
(MLI)  compléte, le montage précédent
en ajoutant une diode D1. 
Due a cette diode, le condensateur se charge 
seulement via RA, vue que RB est court
durant cette phase. en contre partie la décharge 
s'effectue via RB 
 
 
Remarque  
 
La diode D2 montée en inverse dans le 
optionnelle, est permet un meilleur court
RB 
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de base 

Dans le cas du montage astable, le circuit ne possède pas d'état stable, et par conséquent 
fonctionne comme oscillateur. 

d'oscillation et le rapport 
cyclique sont fixés avec deux résistances et un 

Une oscillation complète est effectuée lorsque 
1/3 Vcc  jusqu'à 

Durant  la charge, les résistances RA et RB 
série avec le condensateur, mais la 

uniquement à travers RB.  
rapport cyclique peut être 

Simuler et vérifier le fonctionnement du circuit, en modifiant les valeurs de R
isualiser dans un Graph les deux signaux indiqués dans le schéma. 

Déterminer les limites du rapport cyclique qu'on peut avoir avec ce schéma.
l'expression de la fréquence, et du rapport cyclique du signal 

expérimentalement le fonctionnement. 

(MLI)  

Afin de permettre une variation du rapport cyclique , 
c'est a dire une modulation de largeur d'impulsion 

précédent est modifié 

Due a cette diode, le condensateur se charge 
seulement via RA, vue que RB est court-circuitée 
durant cette phase. en contre partie la décharge 

montée en inverse dans le schéma est 
est permet un meilleur court-circuit de 

, le circuit ne possède pas d'état stable, et par conséquent 

Simuler et vérifier le fonctionnement du circuit, en modifiant les valeurs de RA et C1. 

Déterminer les limites du rapport cyclique qu'on peut avoir avec ce schéma. 
et du rapport cyclique du signal 



 
 
Le montage suivant est souvent utilisé dans certaines applications, qui  nécessitent une 
variation du rapport cyclique (sur l'intervalle  0
 

 
- Simuler et vérifier le fonctionnement du circuit, en modifiant les valeurs du potentiomètre.
 
-mesurer la fréquence du signal généré, ainsi que la limite basse et haute du rapport cyclique.
 
-Justifier théoriquement et vérifier expérimentalemen
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Le montage suivant est souvent utilisé dans certaines applications, qui  nécessitent une 
(sur l'intervalle  0-100%)    via un potentiomètre 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Simuler et vérifier le fonctionnement du circuit, en modifiant les valeurs du potentiomètre.

mesurer la fréquence du signal généré, ainsi que la limite basse et haute du rapport cyclique.

Justifier théoriquement et vérifier expérimentalement les résultats obtenues

Le montage suivant est souvent utilisé dans certaines applications, qui  nécessitent une 
via un potentiomètre  

Simuler et vérifier le fonctionnement du circuit, en modifiant les valeurs du potentiomètre. 

mesurer la fréquence du signal généré, ainsi que la limite basse et haute du rapport cyclique. 

t les résultats obtenues 
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La simulation des Circuits Logiques 
 
 

 
Dans cette partie on s’intéresse à la simulation par Proteus des circuits logiques de base 
En plus des outils de d'analyse et de visualisation déjà décrits dans les sections précédentes, 
Proteus permet d'utiliser des pins d'entrée/sortie spécifiques au signaux logiques, facilitant 
ainsi la tache de simulation. 
  
5.1 L'Analyseur logique 
 
Cette instrument permet l'enregistrement continu de données numériques, via un processus 
d'échantillonnage dont la résolution définit l'impulsion minimale détectable. 
La mémoire tampon de l'analyseur permet la sauvegarde de 10.000 échantillons, avec un 
control du temps de déclanchement de la capture des signaux. 
Des mesures précises de largeur d'impulsion par exemple, sont possible grâce à un ensemble 
de marqueurs de mesure.   
  
 
 
 
 
 
 
 
 
 
 
 
 
Les caractéristiques de l'analyseur (dépend de la version utilisée) sont : 
- 16 Courbes 8x1 bit 
- 4 Bus 2x8 bits 
- Résolution de 0.5ns à200us 
- Temps de capture de 5ms à 2s  
- Affichage réglable de 1 à 1000 échantillons/Division 
- Deux curseur pour mesure de temps 
- Déclenchement (Trigger) sur combinaison 'et' des état des entrées 'et/ou' fronts ainsi que les 
valeurs des bus.   
- Réglage du déclenchement à un point entre 0 et 100% de la trame. 
 
 
 
 
 
 
 



 
 
 
5.2 Les portes logiques TTL et CMOS
 
 Dans cette application, on S'intéresse a la comparaison des performances des portes logiques 
(inverseurs) réalisées par des technologies 
CD4049). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
- Réaliser, et simuler le schéma proposé
- Après le lancement de la simulation interactive procéder a un réglage adéquat de l'analyseur 
logique. 
  
* Le bouton résolution définit la petite largeur d'impulsion pouvant être enregistrée
*  Les condition de déclenchement (Trigger ) sont pr
* Le déclenchement de l'enregistrement des donnée est réaliser via le bouton Trigger, qui 
change de couleur (vert) durant le temps d'échantillonnage. 
 
 - En changeant le calibre d'affichage et le curseur de mesure, comparer les performances 
temporelles (delay time, rise time,...) 
 
 
  
 
 
 
    

 
 
 
 
 
 
- Via une recherche bibliographique, comparer la technologie de conception de 
chaque circuit. 
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ortes logiques TTL et CMOS 

, on S'intéresse a la comparaison des performances des portes logiques 
(inverseurs) réalisées par des technologies de conceptions différentes (7404, 74HC04, 

Réaliser, et simuler le schéma proposé 
simulation interactive procéder a un réglage adéquat de l'analyseur 

* Le bouton résolution définit la petite largeur d'impulsion pouvant être enregistrée
*  Les condition de déclenchement (Trigger ) sont précisées dans la liste à droite du menu
* Le déclenchement de l'enregistrement des donnée est réaliser via le bouton Trigger, qui 

durant le temps d'échantillonnage.  

En changeant le calibre d'affichage et le curseur de mesure, comparer les performances 
delay time, rise time,...) des trois circuits logiques. 

Via une recherche bibliographique, comparer la technologie de conception de 

, on S'intéresse a la comparaison des performances des portes logiques 
(7404, 74HC04, 

simulation interactive procéder a un réglage adéquat de l'analyseur 

* Le bouton résolution définit la petite largeur d'impulsion pouvant être enregistrée 
la liste à droite du menu. 

* Le déclenchement de l'enregistrement des donnée est réaliser via le bouton Trigger, qui 

En changeant le calibre d'affichage et le curseur de mesure, comparer les performances 

Via une recherche bibliographique, comparer la technologie de conception de 



5.3 La bascule S-R Asynchrone
 
La bascule SR est un circuit séquentiel de base, et les autres 
asynchrone) se basent pratiquement sur cet
les différentes combinaisons des
la remise à 0, ou une mémorisation de l'
bascule peut prendre différentes formes, dont 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
La figure ci-dessus , illustre un exemple de réalisation d'une bascule SR avec des porte NOR 
(7402). 
- simuler le circuit, et vérifier sa table de vérité.
 
Remarque 
Dans le schéma proposé sont utilisés des entrées analogiques (Logicstate) et des sondes 
logiques (Logicprobe)   
 
5.4 La bascule S-R Synchrone 
Dans ce cas un signal d'horloge H  synchronise le fonctionnement du circuit.
la bascule fonctionne comme une 
SR classique durant le niveau haut.

 
 
 
 
 
 
 
 
 
 
- Simuler le circuit proposé, et vérifier sont fonctionnement et sa table de vérité.
-Modifier le schéma afin de permettre une visualisation des 
analyseur logique. 
Pour cette finalité utiliser en entrée (S,R,H) des générateur de type 
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ynchrone 

bascule SR est un circuit séquentiel de base, et les autres types de bascules (synchrone ou 
pratiquement sur cette bascule. 

s combinaisons des deux signaux d'entrée R et S permettent soit la mise à 1, 
, ou une mémorisation de l'état de la bascule. Pratiquement la réalisation de cette 

bascule peut prendre différentes formes, dont l'une  est traitée par la suite. 

dessus , illustre un exemple de réalisation d'une bascule SR avec des porte NOR 

simuler le circuit, et vérifier sa table de vérité. 

Dans le schéma proposé sont utilisés des entrées analogiques (Logicstate) et des sondes 

Synchrone (SRH) 
Dans ce cas un signal d'horloge H  synchronise le fonctionnement du circuit.
la bascule fonctionne comme une mémoire durant le niveaux bas de H, et comme une bascule 
SR classique durant le niveau haut. 

imuler le circuit proposé, et vérifier sont fonctionnement et sa table de vérité.
Modifier le schéma afin de permettre une visualisation des entrées

 
Pour cette finalité utiliser en entrée (S,R,H) des générateur de type 

bascules (synchrone ou 

signaux d'entrée R et S permettent soit la mise à 1, soit 
réalisation de cette 

dessus , illustre un exemple de réalisation d'une bascule SR avec des porte NOR 

Dans le schéma proposé sont utilisés des entrées analogiques (Logicstate) et des sondes 

Dans ce cas un signal d'horloge H  synchronise le fonctionnement du circuit. 
durant le niveaux bas de H, et comme une bascule 

imuler le circuit proposé, et vérifier sont fonctionnement et sa table de vérité. 
entrées/sorties sur un 

Pour cette finalité utiliser en entrée (S,R,H) des générateur de type PWLin . 



5.5 Encodeur et Afficheur 7 Segments
 
Dans l'exemple suivants u
affichage sur un 7 segments 
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
- Réaliser le montage
- Modifier le montage en remplaçant le décodeur par un circuit à base de portes 
logiques élémentaires.   
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Encodeur et Afficheur 7 Segments 

Dans l'exemple suivants un décodeur  BCD/7Segmen (4511) est 
affichage sur un 7 segments à cathode commune. 

Réaliser le montage, puis prélever et vérifier la table de vérité. 
Modifier le montage en remplaçant le décodeur par un circuit à base de portes 

logiques élémentaires.    

) est utilisé pour un 

prélever et vérifier la table de vérité.  
Modifier le montage en remplaçant le décodeur par un circuit à base de portes 



 
 
Dans cette partie on s’intéresse à
microcontrôleurs avec le logiciel
L'initiation est faite via un ensemble d'applications; dont la tota
du microcontrôleur PIC18F452 de MICROCHIP
étudiés dans d'autres modules 
 
6.1 Simulation et configuration de base:
 
Le circuit de base d'un systeme à 
microcontrôleurs comprend généralement et en 
particulier (figure ci-contre): 
- Un circuit RESET, qui peut être un simple 
circuit RC 
- Un circuit d'horloge, qui est généralement un 
oscillateur à quartz. 
 
 
  Un  double clic sur le microcontrôleur utilisé 
permet la définition de sa fréquence de 
fonctionnement, et du nom du fichier contenant 
le code machine (fichier.hex) qui sera exécuté 
durant la simulation.   
 
 
Application 1 
- Lancer Proteus, et développer le circuit à base 
du 18F452 ci-contre. 
- Lancer MPLAB, puis éditer et compiler le 
programme assembleur suivant.
- Simuler le circuit précédent, en lui associant le 
programme donné. 
- Déterminer la nature des signaux générées sur le 
PORTD. 
-  Modifier le programme pour réduire la fréquence 
des signaux générés au quart. 
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La simulation des microcontrôleurs

Dans cette partie on s’intéresse à la simulations des systèmes à base de Microprocesseurs / 
microcontrôleurs avec le logiciel Proteus. 
L'initiation est faite via un ensemble d'applications; dont la totalité sont des exemples à base 

rôleur PIC18F452 de MICROCHIP, vu que' ce type de microcontrôleurs 
 

Simulation et configuration de base: 

Le circuit de base d'un systeme à 
microcontrôleurs comprend généralement et en 

, qui peut être un simple 

Un circuit d'horloge, qui est généralement un 

Un  double clic sur le microcontrôleur utilisé 
permet la définition de sa fréquence de 

u fichier contenant 
le code machine (fichier.hex) qui sera exécuté 

er le circuit à base 

Lancer MPLAB, puis éditer et compiler le 
programme assembleur suivant. 

Simuler le circuit précédent, en lui associant le 

Déterminer la nature des signaux générées sur le 

Modifier le programme pour réduire la fréquence 
 

microcontrôleurs 

des systèmes à base de Microprocesseurs / 

lité sont des exemples à base 
microcontrôleurs est déjà 



 
 

Application 2 
 

- Lancer Proteus, et développer le 
circuit  ci-contre, ou le port D du 
18F452 est connecté a un 7 segment à 
cathode communes, 
les pins RB0-RB3 sont contrôlé
des entrées logiques.  
 
- Lancer MPLAB, puis éditer et 
compiler le programme assembleur 
donné. 
 
- Simuler le circuit précédent, en l
associant le programme donné, et 
vérifier le fonctionnement. 
 
- Modifier le programme proposé, pour 
permettre un décodage complet  
BCD/7Segmen des 4 pins du PORTB 
ainsi qu'un affichage simultané sur le 7 
segments 

 
 
6.2 Le mode pas à pas 
 
La simulation en mode pas à pas sous 
PROTEUS est possible avec un 
affichage du programme associé au 
microcontrôleur ainsi que ses registres 
internes. Il est même possible d’ajouter 
des points d’arrêts afin de permettre un  
meilleur débogage.   
 
Le fichier qui sera associé au 
microcontrôleur ne sera plus un 
exécutable de type (*.hex) mais plutôt de 
type (*.cof), vu qu’il contient le fichier source et les directives
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Proteus, et développer le 
contre, ou le port D du 

18F452 est connecté a un 7 segment à 

contrôlées par 

Lancer MPLAB, puis éditer et 
le programme assembleur 

uler le circuit précédent, en lui 
associant le programme donné, et 

Modifier le programme proposé, pour 
permettre un décodage complet  
BCD/7Segmen des 4 pins du PORTB 
ainsi qu'un affichage simultané sur le 7 

La simulation en mode pas à pas sous 
PROTEUS est possible avec un 
affichage du programme associé au 
microcontrôleur ainsi que ses registres 

possible d’ajouter 
des points d’arrêts afin de permettre un  

fichier qui sera associé au 
microcontrôleur ne sera plus un 
exécutable de type (*.hex) mais plutôt de 
type (*.cof), vu qu’il contient le fichier source et les directives de désassemblage.de désassemblage. 



 
 
 
 
 
 

 
 
 
 
 
 
 
Application 3 
 
- Exécuter l’application 2 en mode pas à pas.
- Modifier le programme proposé, pour permettre un décodage complet  BCD/7Segmen
4 pins du PORTB ainsi qu'un affichage simultané sur le 7 segments
 
Remarque 
 Les versions de PROTEUS antérieurs à la version 8, ne reconnaissent pas les fichiers de type 
(*.cof), mais il est tout de même possible de configurer le mode pas
suivantes: 
- Dans le menu « Source » Sélectionner
'New', et sélectionner le fichier
- MPASM  est l'outil de génération de code
( ce compilateur est lancé par PROTEUS durant l
'*.hex') 
- le fichier exécutable (*.hex) doit aussi être associé au microcontrôleur (le champ 'Program 
File ' du composant. 
- Apres le lancement du mode DEBUG, les fenêtres de mise au point peuvent etre affichées 
par l'intermédiaire du menu 'Debug' ( les fenêtres: 'Registers', 'Source Code', et 'Data 
Memory'). 
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cation 2 en mode pas à pas. 
Modifier le programme proposé, pour permettre un décodage complet  BCD/7Segmen

4 pins du PORTB ainsi qu'un affichage simultané sur le 7 segments 

Les versions de PROTEUS antérieurs à la version 8, ne reconnaissent pas les fichiers de type 
(*.cof), mais il est tout de même possible de configurer le mode pas-à

Sélectionner 'Ajout/suppression fichiers source', puis c
le fichier source(*.asm). 

est l'outil de génération de code pour les microcontrôleurs PIC qu'il faut choisir
r PROTEUS durant l’animation, et générera le code machine 

le fichier exécutable (*.hex) doit aussi être associé au microcontrôleur (le champ 'Program 

Apres le lancement du mode DEBUG, les fenêtres de mise au point peuvent etre affichées 
re du menu 'Debug' ( les fenêtres: 'Registers', 'Source Code', et 'Data 

Modifier le programme proposé, pour permettre un décodage complet  BCD/7Segments des 

Les versions de PROTEUS antérieurs à la version 8, ne reconnaissent pas les fichiers de type 
à-pas par les étapes 

, puis cliquer sur 

pour les microcontrôleurs PIC qu'il faut choisir. 
générera le code machine 

le fichier exécutable (*.hex) doit aussi être associé au microcontrôleur (le champ 'Program 

Apres le lancement du mode DEBUG, les fenêtres de mise au point peuvent etre affichées 
re du menu 'Debug' ( les fenêtres: 'Registers', 'Source Code', et 'Data 
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6.3 Rappel sur MPLAB  
 
L’environnement de développement intégré MPLAB  fournit par le constructeur Microchip , 
est un outil qui regroupe un éditeur de texte, un compilateur MPASM , un outil de simulation, 
et un logiciel de programmation. Parconsequent il y a une possibilité de l’associer à 
PROTEUS pour constituer une plateforme de dévellopement et de simulation très utile. 
Dans cette section on décrira en bref comment créer un projet sous MPLAB , puis comment 
l’associer a PROTEUS via un ensemble d’exemples. 

 
La notion de projet 
 
Un projet est un fichier (extension : *.mcp) qui permet de gérer entre autres les fichiers de 
code assembleur, la référence et les paramètres du microcontrôleur ainsi que les options et les 
outils de débogage. 
Par conséquent pour chaque application il est intéressant de définir un nouveau projet. 
 
Création d’un nouveau projet : 
 
Apres le lancement de MPLAB, On peut créer un nouveau projet : 
- Soit  en passant par project �New, 
 Où on sera ramé à définir un nom et un répertoire pour le projet.  
- Soit  en passant par l’assistant ‘Project Wizard’ qui sera utilisé par la suite. 
 
Définition du projet avec l’assistant 
 

 
 

- Dans le menu Project, sélectionner Project 
Wizard . Cela lance un assistant permettant de 
définir certaines options du projet. 
 
 
- La première étape consiste à Sélectionner 
d'abord un microcontrôleur 
 
 
- L’étape suivante permet le choix des 
programmes de développement .on gardera 
l’ensemble logiciel  de Microchip  
 



23 
 

 
 

 
 
 
 
 

- Ensuite, il faut choisir un nom et un 
emplacement pour le nouveau projet 
(utiliser browse pour spécifier le nom et 
le répertoire de travail). 
 
- La fenêtre suivante permet l’ajout de 
fichiers existants au projet (cette phase 
n’est pas toujours nécessaire). 
 
- La dernière fenêtre du wizard résume 
les principaux  paramètres du projet, qui 
est automatiquement crée après avoir 
cliqué sur ‘finish’ .  
 
Remarque  
 
- Le projet ainsi crée est vide, par  
conséquent il est nécessaire d’ajouter en 
particulier des fichiers sources (en 
assembleur).  
- Une fois le fichier source (.asm) est édité 
utiliser (project �add files to project) 
pour l’ajouter au projet. 
- Pour la sauvegarde du projet utiliser 
(project �save project) 
 
 
 



Changement de compilateur
 

Sous l’environnement MPLAB, la création d’un projet  peut se faire en utilisant 
d’autre compilateur que l’assembleur, en particulier les compilateurs C (par exemple CCS ou 
C18) . Dans ce cas les étapes de configuration sont les 
1. Lancez MPLAB 
2. Créer un nouveau projet, et s
3. Si vous utilisez le ‘project wizard’

d'un compilateur( exemple: 
    En cas d’oubli réaliser cette
    Project>Select Language Toolsuite 
4. Cliquer sur le menu   

project>Build option>Project 
une fenêtre Build option s’ouvre
dans la sous fenêtre ‘Directories and                                                                    
search paths’ cliquer sur  ‘
search path’, vous cliquez sur 
ensuite sur les points pour chercher                                                                          
le repertoire(exemple: C:\MCC18
 
faites la même chose pour ‘
search path’(le répertoire 

ensuite la même chose pour ‘Linker                                                                                
search path’(le répertoire C:\

 
 
 

6.4 L’Association de PROTEUS
 
Le simulateur 
PROREUS est intégré à 
l’environnement de 
développement MPLAB 
comme outil de 
débogage, chose qui 
facilite la réalisation 
rapide d’applications.  
Apres le lancement de 
MPLAB, et la création 
d'un nouveau projet il 
suffit par l'intermédiaire 
du menu 'Debug' ( Select 
tool>> Proteus VMS) 
d'ouvrir une nouvelle 
fenetre pour afficher le 
schema réalisé par 
proteus. 
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Changement de compilateur  

Sous l’environnement MPLAB, la création d’un projet  peut se faire en utilisant 
d’autre compilateur que l’assembleur, en particulier les compilateurs C (par exemple CCS ou 

de configuration sont les suivantes : 

et sélectionner un répertoire de sauvegarde. 
project wizard’  il faut s’assurer au niveau de l’étape 2 

d'un compilateur( exemple: C18  "Microchip C18 Toolsuite") 
cette configuration en passant par : 

roject>Select Language Toolsuite  

project>Build option>Project  
s’ouvre,                                                                                  

Directories and                                                                    
’ cliquer sur  ‘Include                                                                               
, vous cliquez sur New                                                                

ensuite sur les points pour chercher                                                                          
MCC18\h).  

faites la même chose pour ‘Library                                                                                
 C:\MCC18\lib )    

Linker                                                                                
\MCC18\lkr ) 

 
ROTEUS à MPLAB 

Sous l’environnement MPLAB, la création d’un projet  peut se faire en utilisant 
d’autre compilateur que l’assembleur, en particulier les compilateurs C (par exemple CCS ou 

e l’étape 2 de la sélection 

,                                                                                  
Directories and                                                                    

                                                                                
                                                 

ensuite sur les points pour chercher                                                                          

Library                                                                                 

Linker                                                                                 



Le module ARES de conception de
 
 
Dans cette partie, on s'intéresse au logiciel ARES, qui est un module de ISIS
permettant la conception de circuits imprimés.
Ce logiciel permet un placement de composants, ainsi qu'un routage sur 16 couches, soit en 
mode manuel, semi-automatique, ou automatique. 
les algorithmes implémentés dans ce logiciel permette
avec même des outils supplémentaires dans les dernières versions tel que la visualisation 3D 
de la carte réalisée.  
 
7.1 Présentation de l'interface ARES
 
Le lancement d' ARES donne 
PROTEUS. 

 
 
La barre d'outil offre quatre modes, dont les noms sont donnés dans la figure ci
les principaux raccourcis seront dé
de routage automatique. 
 
 
7.2 Routage automatique
 
Il est possible de passer d'un montage simuler 
avec PROTEUS directement a la conception du 
circuit imprimé tel qu'il est expliquer dans 
l'exemple en cours. 
 
On considère le montage astable ci
étudié et simulé avec PROTEUS

 
 

Apres le lancement d'ARES, les étapes de base permettant la conception  du circuit imprimé 
sont les suivantes: 
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e module ARES de conception des circuits imprimés

, on s'intéresse au logiciel ARES, qui est un module de ISIS
permettant la conception de circuits imprimés. 
Ce logiciel permet un placement de composants, ainsi qu'un routage sur 16 couches, soit en 

automatique, ou automatique.  
les algorithmes implémentés dans ce logiciel permettent une optimisation de la conception, 
avec même des outils supplémentaires dans les dernières versions tel que la visualisation 3D 

sentation de l'interface ARES 

d' ARES donne accès à aune interface de développement similaire à celle de 

a barre d'outil offre quatre modes, dont les noms sont donnés dans la figure ci
les principaux raccourcis seront définis et détaillés au fur et à mesure dans 

Routage automatique: 

Il est possible de passer d'un montage simuler 
avec PROTEUS directement a la conception du 
circuit imprimé tel qu'il est expliquer dans 

On considère le montage astable ci-contre déjà 
PROTEUS. 

d'ARES, les étapes de base permettant la conception  du circuit imprimé 

circuits imprimés 

, on s'intéresse au logiciel ARES, qui est un module de ISIS-PROTEUS 

Ce logiciel permet un placement de composants, ainsi qu'un routage sur 16 couches, soit en 

une optimisation de la conception, 
avec même des outils supplémentaires dans les dernières versions tel que la visualisation 3D 

similaire à celle de 

a barre d'outil offre quatre modes, dont les noms sont donnés dans la figure ci-contre. 
 l'exemple suivant 

d'ARES, les étapes de base permettant la conception  du circuit imprimé 



* La première étape, consiste à
graphique (rectangle), pour le tracé et 
des bords du circuit imprimé.  
 
Durant ce tracé la couche 'Board Edge' doit être 
activée 
 
* La deuxième étape, consiste 
composants du circuit, qui peut 
automatiquement via "Tools>Auto

 
* Initialement, désactiver l'affichage des  couches 
(non utilisées) dans "la liste des 
faciliter l'opération de conception du circuit imprimé.
  
remarques 
- La visibilité et la couleur des différentes couches est 
contrôlable via "View>Edit layer colour and 
Visibility". 
- L'affichage de la grille, et le changement de l'unit
de meure des distances se font
"View>Toggle Grid" et "View>Toggle 
Metric/Imperial". 
 
 
* Les règles de conception du circuit imprimé sont 
fixées via "Technology>Design Rule Manager".
Elles définissent le type et taille des 
pistes du circuit.  
Ces règles de routage (sa stratégie
sont définies pratiquement dès la saisie du schéma, 
et sont classées en trois différents type
- POWER : pour les signaux VCC et GND
- BUS : pour les liens nommés
- SIGNAL : pour le reste de liens
 
Un exemple est donné dans la figure ci
 
 
* Le mode "piste" (Trace) permet de définir la taille 
des pistes à concevoir durant le processus de 
routage. 
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à utiliser le mode 
graphique (rectangle), pour le tracé et la délimitation 

 

'Board Edge' doit être 

étape, consiste à placer les 
composants du circuit, qui peut être effectué 

iquement via "Tools>Auto-placer" 

désactiver l'affichage des  couches 
la liste des couches", afin de 

faciliter l'opération de conception du circuit imprimé. 

a visibilité et la couleur des différentes couches est 
contrôlable via "View>Edit layer colour and 

L'affichage de la grille, et le changement de l'unité 
de meure des distances se font respectivement via  
"View>Toggle Grid" et "View>Toggle 

du circuit imprimé sont 
fixées via "Technology>Design Rule Manager". 

définissent le type et taille des différentes 

(sa stratégie de conception)  
pratiquement dès la saisie du schéma, 

et sont classées en trois différents types de routage : 
: pour les signaux VCC et GND 

BUS : pour les liens nommés D[0] 
: pour le reste de liens 

Un exemple est donné dans la figure ci-contre 

* Le mode "piste" (Trace) permet de définir la taille 
durant le processus de 



 
 
* Le lancement du routage automatique est 
effectué via l'icone "auto-router (figure ci
 
 
 
Application 1: 
 
refaire les étapes déjà décrites pour la conception 
d'un circuit double face, puis simple face du 
schéma proposé.  
 
 
 
Application 2: 
 
réaliser un circuit simple face du montage du 
montage astable (à base du NE555) 
 
 
 
Application 3: 
 
réaliser un circuit double face du 
à base du 18f452 déjà décrit et simulé
partie précédente. 
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* Le lancement du routage automatique est 
router (figure ci-contre) 

décrites pour la conception 
d'un circuit double face, puis simple face du 

réaliser un circuit simple face du montage du 
base du NE555) déjà étudié.  

réaliser un circuit double face du denier montage 
à base du 18f452 déjà décrit et simulé dans la 
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Annexe 
 
Dans cet annexe sont donnés des extraits des datasheets fournis par les 
constructeurs des composants suivants :  
 
-  L'amplificateur opérationnel TL082 
 
- Le circuit multifonction NE555 
 
- Le microcontrôleur PIC18F452 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



L'amplificateur opérationnel TL082
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L'amplificateur opérationnel TL082
 

L'amplificateur opérationnel TL082  
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Le circuit multifonction NE555
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Le circuit multifonction NE555Le circuit multifonction NE555 
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Le microcontrôleur PIC18F452 
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